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Getting Started

Let's start with a search for all the picture files on your hard drive.    Picture files for Windows 
are files that have a file extension of BMP.    Here's how to do it:

1. Run File Finder for Windows by double-clicking on the icon.    Make sure that the 
Search Type is "DOS Standard", and enter a search pattern.    Since we want to find all
BMP files, enter "*.BMP" (without the quotes).    This will locate files with any name 
that have an extension of BMP.

2. Turn off the "Search Archives" option in the Options Menu.    File Finder will run faster 
when it is not searching archives.

3. Press Enter or click on the "Search" button, and the search will begin.    When the 
search is c omplete, all the BMP files on your drive will be listed.    You can use the 
scroll bar to scroll the list.    The keys Home, End, Page Up, Page Down, and the up 
and down arrows can all be used to scroll the list.

4. The BMP files can be selected for viewing directly from the list, if a Windows 
"association" has been established.    Try double-clicking on one of the files in the list. 
If Paintbrush runs and shows you the picture, then an association already exists.    If 
no association exists, you will see a message saying "No association defined for .BMP 
files. Use File Manager to define one."    In this event, run the Windows utility "File 
Manager."    In the File menu, select Associate, enter the file extension BMP, select 
"Paintbrush Picture," then click O.K.    Now you should be able to select any BMP file in
the File Finder for Windows file list.

5. Press "Clear" when you are done looking at the list.



A More Complex Search

Now, let's find all the program files that come with Windows.    These file will all have an 
extension of EXE.

1. In the Directories menu, select the drive where you have Windows installed.    This is 
usually the "C" drive.

2. When a drive in the list is selected, a dialog box will be displayed allowing you to 
search the entire drive, by starting in the root directory, or to search only some 
portion of the drive by selecting another directory.    In this case, we want to search 
only the Windows directory, so find the Windows directory by scrolling the directory 
list, if necessary, and double-click on the Windows directory entry.

3. Click "Done."

4. Enter "*.EXE" in the Search Pattern box, and press Enter, or click "Search."

5. A list will be displayed of all programs stored in the Windows directory, including the 
directory C:\WINDOWS\SYSTEM, which is a subdirectory of the Windows directory.    
Double-click on any program to run it.    For example, select CALC.EXE to run the 
Windows Calculator program.

6. Press "Clear" when you are done looking at the list.    Also, you may want to set the 
search directory back to the root directory: C:\



Searching Archives

Check the Search Archives menu item in the Options menu if you want File Finder for 
Windows to search archives to find files.    Files stored within an archive that match the 
search criteria are listed.

Archive types searched are: ARC, ARJ, LBR, LZH, PAK, PKA, ZIP, ZOO



Searching Subdirectories

File Finder searches subdirectories by default.    This is controlled by the Search 
Subdirectories setting in the Options Menu.    If this option is selected, the starting directory 
and all subdirectories below it will be searched.    If this option is not selected, only the 
starting directory for each drive is searched.



Selecting disks

Select the disks that you want File Finder for Windows to search from the Directories menu, 
or by using Quickbuttons.    Only valid disks are listed in the menu and as Quickbuttons.    
When a disk is selected, you will be asked to select a starting directory.

To quickly select the root directory of a drive, turn the Quickbuttons on from the Options 
menu, if they are not visible, and click one time on the button of the disk or disks you want 
to search.



Starting Directories

File Finder for Windows searches start at the root directory by default.    When you select a 
drive in the Directories menu, you will be asked to select a starting directory, which may be 
the root directory of the drive, or a subdirectory.    When you select a starting directory, only 
that directory and subdirectories of that directory are searched.    You may specify a different
starting directory for each drive.

Check Search Subdirectories in the Options Menu to search subdirectories within the starting
directory.

Selecting a drive using a Quickbutton    always set the starting directory for that drive to the 
root directory.



Multiple Searches

When you perform a search with the output window open, you will be given the choice of 
clearing the output window or appending the search to the existing list.

File Finder for Windows can perform many searches in succession.    The results of each 
search can be appended to the end of the list.    Each search will include the parameter 
settings for that search.



Special Characters

You may want to search for files which contain a certain special character, for example, a file
named ESPAÑOL.DOC.    To insert such a character, use the Windows Character Map utility.    
With Character Map, you can select the character that you want to insert, and copy it to the 
clipboard.    In File Finder for Windows, use, <shift>-<insert> to insert that character into the
search pattern.

An alternative method of using Character Map is to use it to find the code that corresponds 
to the character you want, then enter that code using the ALT key and the keypad.



Quickbuttons
The Quickbuttons select drives with a single click.    When a drive is selected with a 
Quickbutton, the starting directory for that drive is set to the root directory.    The 
Quickbutton display and the Directories menu are always kept synchronized, so that a drive 
selected by Quickbutton is shown as selected in the Directories menu, and vice versa.    The 
Quickbuttons display can be turned on or off by selecting Show Quickbuttons in the Options 
menu.



Search Pattern

There are two types of search patterns.    "DOS Standard" is the standard search format that 
you might be familiar with from using DOS or from File Manager.    "Regular Expression" is a 
much more powerful pattern format which allows you to search for filenames which contain 
substrings and complex patterns of characters.

DOS Standard Search Pattern
Select 'DOS Standard' as the Search Type.    In the Search Pattern, enter a file name pattern 
for which to search. The pattern may include the DOS wildcard characters * and ?. Try some 
of these Search Patterns to see how they work:

COMMAND.COM Find all occurrences of COMMAND.COM.
*.* Find all files.
*.EXE Find all executable files (EXE files).
ABC*.* Find all files that start with ABC.    (You might not see any.)
*. Find all files with no extension.
AB?C.* Find all files that start with AB, have any character in the third position,

and a C in the fourth position.

"Regular Expression" Search Pattern
The most complex and most powerful Search Type is 'Regular expression.'    Regular 
expressions can be used to search for a substring within a filename.    They can also be used 
in more complex ways.

For a simple substring search, select the Regular Expression Search Type, enter a string of 
characters in the Search Pattern, the click the Search button.    For example, search for the 
string 'WRI' in the Windows directory, and you will find that WRITE.EXE, WRITE.HLP, 
README.WRI, WININI.WRI, and probably some other files are listed.    Each of these filenames
contains the string 'WRI.'

You may want to get acquainted with File Finder for Windows in general before you delve 
into complex regular expressions. Look at the following list of characters allowed in a regular
expression, then read and try the examples that follow.    A regular expression may contain:

1. Any character other than: . \ [ ] * + ^ $ matches itself.    That is, an 'A' in the search 
pattern must match to an 'A' in a file name for that file to be listed.

2. A period (.) is a wildcard that matches any character.

3. A backslash is used to override the special behavior of      . \ * + ^ $ to allow matching
on these characters.    For example, '\*' will match on an asterisk (*). '\\' will match on 
the backslash (\) character.    A backslash also has other uses, described below.

4. A sequence of characters surrounded by square brackets is known as a 'set', and 
matches any character in the set.    For example, [ABCD] will match on any of the 
characters A, B, C, or D.    [A-Z] matches on any alphabetic character.    [A-Z0-9_] 
matches on any alphanumeric character or the underscore character.    Using the 
character '^' at the beginning of the set, is a 'NOT' and reverses the meaning of the 
set.    [^A-Z] will match on any character that is NOT an alphabetic character.



5. An asterisk (*) indicates that the prior character, as specified in 1 through 4, occurs 
at least 0 times.

6. A plus sign (+) indicates that the prior character, as specified in 1 through 4, occurs 
at least 1 time.

7. A regular expression in the form 1 through 9, beginning with '\(' and ending with '\)' 
matches the expression, and creates a numbered 'TAG'.    This tag can then be used 
to match on the identical character later in the expression.    The tags are numbered 1
through 9, and are used as shown in 8.    For example, the expression    \([A-Z]\) 
matches any character A through Z, and creates a tag.    If the expression matches an
'L', a tag is created which will also match on an 'L'.

8. A backslash (\) followed by a number from 1 to 9 matches whatever the tagged 
expression matched.    For example, if the tag created in form 7 matched on an 'L', 
and was the first expression of this form, the expression \1 will match only on the 
character 'L'.

9. The expressions \< and \> force the string to match on the beginning and ending of a
word, respectively.    In this context, the filename and the file extension are "words."    
An example would be using 'C\>' to match all files which have either a filename or 
file extension which ends with 'C'.

10. An expression beginning with ^ or ending with $ anchors the expression to the 
beginning or the end of the filename.

These rules are fairly complicated if you have never worked with regular expressions before, 
but some examples may help.

For the first example, assume that you have done a search using the 'DOS Standard' Search 
Type, with a Search String of '*.DOC', and you found a number of temporary documents on 
your drive, which start with the '~' character.    You can use the expression 
^[^~].*\.DOC$
with a 'Regular expression' to list all 'DOC' files which do not start with the '~' character.    
The first '^' anchors the expression to the beginning of the file name.    The set [^~] which 
specifies the match conditions for the first character, indicates that the character should not 
be a '~'.    The '.*' which follows the set uses the period, which is the wildcard character, 
followed by the asterisk, which indicates that there may zero or more characters following 
the first character.    The '\.' is used to match on the period in the filename, followed by 'DOC'
to match on the file extension, and '$' which anchors the expression to the end of the 
filename.

For another example, let's say that you have a group of files that start with a couple 
characters, followed by a numeric sequence, like this:

AS0004.DOC
AS0004A.DOC
AS0008.DOC
AS0009.DOC
AS0009A.DOC
AS0009B.DOC
AS0013.DOC

You can use File Finder for Windows to generate a list of these files using the Regular 



expression Search Type.    Select Regular expression, and enter this search string:
^AS[0-9]+.*DOC$

The first character (^) anchors the string to the beginning of the file name.    The following 
two characters (AS) require an exact match.    Since they are anchored, only the files that 
have 'AS' as the first characters will match.    The next expression is a set which matches any
numeric character, repeated at least once, as indicated by the plus sign.    Next is the period,
which is a wild card, and will match whatever character(s) follow the sequence of numbers.   
The final 'DOC$' will match only files with a filetype of DOC.

Regular expressions will also allow you to search for files with repeated characters.    This 
example uses the forms 7 and 8 as shown above.    The expression \([A-Z]\)\1 creates a tag 
numbered 1 which matches on any letter, followed by \1 which will match on the same letter
as the first match.    That is, if the first expression matches on K, the second must also match
on K.    In this example, the letters must be adjacent to match.

In order to match on non-adjacent repeated characters, add a wildcard between the creation
of the tag and the use of the tag.    For example, \([A-Z]\).*\1 will match on any letter, 
followed any number of intervening characters (even no intervening characters), followed by
the first match again.

Try experiments with regular expressions to see how they work.



Search Type
The Search Type can be:

'DOS Standard', which works in the same way as the DOS 'DIR' command, including 
the wildcards * and ?.
Search Pattern:DOS Standard
'Regular expression'.    The search string is a "regular expression."
Search Pattern:Regular Expressions



Date and Time Ranges

Date Range searches are an important feature of File Finder for Windows.    You may 
remember that you created a file yesterday, or last week, but not remember the name.    By 
using the Date Range, you can list all files or selected files that have been created in the 
range you specify.    The Time Range fields are available to further restrict your search.

The format for Date and Time Ranges are specified using the Windows Control Panel, in the 
International section.    When you enter a date and time, they are checked to make sure that 
they have been entered in the appropriate format.    When the dates are displayed, they will 
be displayed in the format that you have chosen, so use the same format when you make 
changes.

DOS dates are always in the range from January 1st 1980 through December 31st, 2099.    
File Finder for Windows will not allow you to enter dates outside this range.

DOS times will displayed in either 12-hour format with A for A.M. and P for P.M., or they will 
be displayed in 24-hour format.    One peculiarity about DOS file times is that odd seconds 
are changed to an even number when they are saved, so you will never see a file with an 
odd number of seconds in the time stamp.    When you enter a time that has an odd number 
of seconds, it will be changed to an even number when you begin your search.    The 
exception to this is that if you enter 11:59:59P or 23:59:59 (depending on the format), it will 
not be changed, so that you will know that you are getting the full range of times.

The button marked Reset will reset the Date, Time, and Size Ranges to the full ranges, 
without changing any other settings.



Size Range

One way you can use this feature is to find large files that need to be removed or copied of 
off a hard drive.    The range of files sizes supported by DOS is from 0 to 2,147,483,647 
bytes.

The button marked Reset will reset the Date, Time, and Size Ranges to the full ranges, 
without changing any other settings.



Buttons

They can be clicked with the mouse or selected with the keyboard by pressing ALT and one 
of the following letters:

S - Search
Begin the search process, using the parameters entered.    The search time and the 
number of files found includes all searches perfomed.    See "Multiple Searches" for an
explanation of how successive searches are handled.

C - Clear
Clear the search pattern and the list of files to begin another search.      The File Finder
for Windows output window will be closed.    You can also begin a new search without 
clearing first, and the files will be added to the current list.

R - Reset
Reset restores the Date, Time, and Size ranges to the minimum and maximum 
values, so that all files are selected.    The range of dates supported by DOS is January
1, 1980 through December 31, 2099.    The range of files sizes supported by DOS is 
from 0 to 2,147,483,647 bytes.



Output Window

The File Finder for Windows output window displays the search parameters for each search, 
and holds a list of all files found. This window can be scrolled using the scroll bar or the 
keyboard.    Keys which can be used are Home, End, up-arrow, down-arrow, PageUp, and 
PageDown.    You can flip back and forth between the Output Window and the Main Window 
using CTRL-TAB.

The formatting of the file size, date, and time are controlled by the default Windows settings,
which are selected in Control Panel's International section.

In addition to listing files found, any file in the list can be selected with a double-click.    If the
program is an executable, File Finder for Windows will run the program.    If the file is not an 
executable, File Finder for Windows will run whatever application is associated with the file 
selected.    If no association is defined, File Finder for Windows will display a message.    
Associations can be defined in the File Manager.    From the File menu, select Associate, and 
follow the procedure to define an Association.

Files which are in archives can be extracted, provided that the appropriate de-archiving 
program exists and is Associated with the archive type.    For example, assume that you have
a program PKUNZIP.EXE which will extract .ZIP files.    In File Manager, associate the program 
PKUNZIP with the file extension ZIP.    When you double-click on a file in an archive, you will 
be given the option of extracting that file, or the whole archive.    The files extracted will be 
placed in the same directory as the archive.

If you do not have a separate de-archive program for a particular type of archive, set up 
a .BAT file which will issue the proper commands.    For example, to create a "de-archive 
program" for ARJ files, create this file "ARJE.BAT", and associate it with the ARJ extension:

arj e %1 %2 %3 %4 %5 %6 %7 %8 %9

Assuming ARJ.EXE exists, you will be able to extract files from ARJ archives.



File Menu

Copy to Clipboard
Copy the list of files found to the clipboard. Also copied are the search patterns and 
search options.    Any word processor can then use the Paste Option to insert the list 
from the Clipboard.
This option is disabled if there is no file list to copy.

Save Options
The options shown in the Save Options dialog control the format of the file written 
when you choose Save As.    The options are:
* Write List Header - When this option is selected, the header information from the

file list is written to the file.
* Write File Information - When this option is selected, all of the file information, 

such as the size and date, are written to the output file.
* Write Path on Each File - This option controls the format of the path information 

written to the file.    When it is selected, the full path name is written on each file.    
If it is not selected, the path name is written on a line by itself, followed by the list 
of files found in that directory.

* Convert to OEM - If the file you are writing will be used in DOS, select this option. 
This will ensure that international characters are converted properly.    If you will be
using the file in another Windows application, turn this option off.

* Prefix - A string entered here will be written before each file line in the output file. 
This is commonly used to enter a DOS command when a DOS batch file is being 
created.    If you want a space on the line between the prefix and the file, you must
type it.    No assumption is made that the prefix is a DOS command, requiring a 
space, since the prefix can be used for other purposes.

* Suffix: - A string entered here will be written after each file line in the output file.   
A common use is for options on a DOS command.    Again, if you want a space 
here, you must type it.

Save As
Write the list of files found to a file.    The format of the file written is controlled by the
settings in the Save Options dialog.
This option is disabled if there is no file list to copy.

Print
Print the list of files found. Also printed are the search pattern and the search options.
The font and printer used are controlled in Printer Setup.
This option is disabled if there is no file list to copy.

Printer Setup
Use this option to select printer and font settings.    These settings effect the printed 
list of files, and the printing of the registration form from the About menu.    Only 
monospaced (nonproportional) fonts are listed, so that file listings are displayed 
properly.    Click 'Setup' to choose settings specific to your printer.

Exit



Leave the File Finder for Windows program.    The search pattern, the Options 
settings, and the selected disks and directories are saved.    When File Finder for 
Windows is run again, these options are restored.



Options Menu

Search Archives
If this option is selected, all archive types will be searched.    See "Searching Archives"
for a list of archive types known to File Finder for Windows.

Search Subdirectories
If this option is selected, all subdirectories will be searched.    If it is not selected, only 
the starting directories will be searched.

Skip Bad Archives
If this option is selected, archives with invalid structures will be ignored.    If it is not 
selected, File Finder for Windows will display a message about each bad archive it 
finds.

Show Quickbuttons
Selecting this option toggles the Quickbuttons display.    See the section Quickbuttons 
for an explanation of how Quickbuttons are used.

Beep When Complete
When this option is checked, File Finder will issue a beep when the search is 
complete.

Stop at First File
When this option is checked, File Finder stops after finding a single file.



Directories Menu

This menu shows the starting directory for each drive on your system.    When a drive is 
selected, you will be asked to select a starting directory for that drive.    The starting 
directory may be the root directory, or you may select a subdirectory.

Quickbuttons are related to the directory selections in the Directories menu.    When you 
select a drive and directory through the Directories menu, the corresponding button is 
depressed, giving a visual indication on the main window of which drives are selected.    If 
you choose a drive using a Quickbutton, the corresponding entry in the Directories menu is 
checked, and the starting directory for that drive is set to the root directory.



Help Menu

File Finder Help
Displays Contents screen of File Finder Help.

Using Help
Displays information on using Windows Help.

About File Finder
Show information about File Finder for Windows, and allow printing of the registration 
form.    You should register File Finder for Windows after a sufficient evaluation period 
of less than one month.
How to Register File Finder for Windows



How to Get Technical Support

Technical support is available Monday, Tuesday, Thursday and Friday from 6:00 - 10:00 P.M., 
or Saturday from 10:00 A.M. to 6:00 P.M.    at (314) 781-8709.    Technical support is also 
available through Compuserve by writing to 73613,3606.    You may also write to:

Simian Id Software
P.O. Box 430011
St. Louis, MO 63143
USA



How to Register File Finder for Windows

You should register File Finder for Windows after a sufficient evaluation period of less than 
one month.    It will probably take you less time than this to decide.    Register today!

First, make sure that your printer is ready to print. Then, select the About menu.    Click the 
Print Registration Form button and the registration form will print.    Registered users will 
receive the latest version of File Finder for Windows, technical support, an illustrated
User Manual, and discounts on upgrades. Please include comments and suggestions for 
improvements. Thank you for supporting shareware!

If you do not have a printer, simply send your name, address, and $20 U.S. to:

Simian Id Software
P.O. Box 430011
St. Louis, Mo. 63143
U.S.A.

Please indicate that you are registering File Finder for Windows, and the version number.    
Also indicate what diskette size you prefer, either 5¼" or 3½".    Shipping and handling is 
free to the U.S. and Canada.    Overseas orders add $3 for shipping and handling charges.

If you prefer to pay in a currency other than U.S. dollars, add $2 to the charge to cover 
banking fees, use the current exchange rate to convert it, and send the equivalent amount 
in your own currency.    You will probably find that this makes it easier and cheaper than 
having a check issued in U.S. dollars.

Thank you for supporting the Shareware concept! Any comments or suggestions for 
improvement are welcome, and will help to make this a more useful program for everyone!



What is Shareware?

This definition of Shareware was written by Paul Mayer, author of GRAB Plus:

Shareware distribution gives users a chance to try software before buying it.    If you try a 
Shareware program and continue using it, you are expected to register.    Individual programs
differ on details -- some request registration while others require it, some specify a 
maximum trial period.    With registration, you get anything from the simple right to continue
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below.    Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality.    (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution.    The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group.    For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software.    You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware.    The Shareware 
system makes fitting your needs easier, because you can try before you buy.    And because 
the overhead is low, prices are low also.    Shareware has the ultimate money-back 
guarantee -- if you don't use the product, you don't pay for it.



ASP Ombudsman

As of November, 1993, Simian Id Software became a member of the Association of 
Shareware Professionals (ASP).    ASP ensures standards of software and support within the 
Shareware industry.    If you have any dispute with Simian Id Software which is not resolved 
to your satisfaction, you may go to the ASP Ombudsman for help.    ASP requires its authors 
to include this statement:

This program is produced by a member of the Association of Shareware Professionals (ASP).   
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members products.
Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442-9427 USA, 
FAX 616-788-2765 or send a Compuserve message via CompuServe Mail to ASP 
Ombudsman 70007,3536.



Wildcards are the characters ? and * that can be specified in a search pattern. ? indicates 
that any character is a match in this position. * indicates that any number of characters 
which follow are a match.



An archive is a single file which contains a collection of files. The files in an archive are 
usually compressed, to take less disk space. The advantages of using archives include using
less space for file storage, and easier copying and moving of file collections.



Shareware is a means of distributing software. The basic concept is that programs are 
distributed for free, by means of electronic bulletin boards, computer networks, and 
shareware vendors. Its main advantage is that it allows computer users to try software 
before buying (registering) without the need to spend much money up front. By distributing
software in this fashion, software can be made available for a much lower cost than 
traditional commercial software. Also, shareware software companies are usually more 
responsive to suggestions than traditional companies.



A root directory is the highest-level directory on a drive.    For example, C:\ is the root 
directory of the C drive.




